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RX ファミリ 
RX65N における Amazon Web Services を利用した FreeRTOS OTA の実現
方法(v202210.01-LTS-rx-1.1.0 以降対応版) 

はじめに 
本アプリケーションノートでは、FreeRTOS with IoT Libraries 上で OTA デモアプリケーションを使用す

る手順を説明します。セキュリティに関する詳細は「ルネサス MCU におけるファームウェアアップデー

トの設計方針(R01AN5548)」を参考してください。 

 

【注】 本アプリケーションノートは FreeRTOS-v202210.01-LTS-rx-1.1.0 以降の FreeRTOS に対応した手
順となります。FreeRTOS-v202107.00 以前の FreeRTOS を使用する場合は「RX65N における 
Amazon Web Services を利用した FreeRTOS OTA の実現方法(R01AN5549)」を参照してくださ
い。 

 

動作確認デバイス 
RX65N、RX651 グループ 

 

ハードウェア 
CK-RX65N 

 

参考ドキュメント 
ルネサス MCU におけるファームウェアアップデートの設計方針 (R01AN5548) 

 

  

https://www.renesas.com/search?keywords=R01AN5548
https://www.renesas.com/search?keywords=R01AN5549
https://www.renesas.com/search?keywords=R01AN5548
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1. 概要 

1.1 システム概要 
本項では、CK-RX65N 搭載のデュアルバンク機能対応マイコン RX65N を使用し、OTA を実現する場合の

動作概要を示します。 

デュアルバンク機能対応マイコンでは、ROM を Execution area（実行領域）と Temporary area(バッファ

領域)に分割することが可能です。Execution area と Temporary area は動的に切り替えることができ、

Execution area で既存バージョンのソフトウェアを動作させながら更新ファームウェアを ROM に書き込む

ことが可能です。 

以下に OTA 実行時のメモリ配置および、デュアルバンク機能を使用したバンクスワップによるメモリ切

り替えの動作を示します。 

 
図 1-1 OTA の動作概要(1) 

(1) Renesas Flash Programmer にてイレーズを実行した状態（ブランク状態） 

(2) Renesas Flash Programmer にてブートローダと初期ファームウェアを結合したデータ※を書き込んだ状

態 ※Boot Loader(bank0) + Initial firmware + RSU Header + BootLoader(bank1)が結合したデータを指

します。RSU Header の詳細については RX ファミリ ファームウェアアップデートモジュール 
Firmware Integration Technology (R01AN6850)の 4.2 イメージファイルをご確認ください。 

(3) リセット解除後、ブートローダ(bank0)がファームウェアの検証を行う 

(4) 初期ファームウェアを起動する 

 
図 1-2 OTA の動作概要(2) 

(5) AWS から更新されたファームウェアを受信すると bank1 に書き込みを行う 

  bank1 に書き込み中は BGO 機能により初期ファームウェアの動作が実行される 

https://www.renesas.com/search?keywords=r01an6850
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(6) 初期ファームウェアによって更新ファームウェアの検証を行う 

(7) bank0 と bank1 を入れ替え（バンクスワップ）、Execution area に bank1 を配置する 

(8) 更新ファームウェアをブートローダ(bank1)が検証する 

bank0 の初期ファームウェアをイレーズし、bank1 に書き込んだ更新ファームウェアを実行する 

 

1.2 動作確認環境(ハードウェア) 
本デモプロジェクトの動作確認環境(ハードウェア)を以下に示します。 

表 1-1 動作確認環境(ハードウェア) 

項目  
使用ボード CK-RX65N（Cellular / Ethernet）（注 1） 
Cellular モジュール RYZ014A（CK-RX65N 同梱） 
SIM LTE Cat-M1 対応 SIM（microSIM）（注 2） 

【注】 1. 本サンプルでは Cellular 通信を使用しています。 
 2. CK-RX65N 付属の SIM カードを使用する場合は、以下アプリケーションノートの 「4.1.5 

Activating SIM card」を参照し、SIM カードのアクティベーションを行ってください。 
SIM activation, Creating the trial account and using Dashboard with RYZ014A or Ethernet 
Application for AWS - Getting Started Guide (R01QS0064) 
 

1.3 動作確認環境(ソフトウェア) 
本デモプロジェクトの動作確認環境(ソフトウェア)を以下に示します。 

表 1-2 動作確認環境(ソフトウェア) 

項目  
統合開発環境 e2 studio 2023-10 
コンパイラ Renesas CC-RX v3.05.00 
FreeRTOS v202210.01-LTS-rx-1.1.0 
ログモニタツール TeraTerm v4.106 
Python Python 3.11.0 
鍵生成ツール Win64 OpenSSL v3.0.12 
フラッシュ書き込みツール Renesas Flash Programmer V3.12.00 
Renesas Image Generator Version3.02（Firmware Update module Rev.2.01 同梱） 
 

  

https://www.renesas.com/jp/ja/document/qsg/sim-activation-creating-trial-account-and-using-dashboard-ryz014a-or-ethernet-application-aws?r=1611756
https://www.renesas.com/jp/ja/document/qsg/sim-activation-creating-trial-account-and-using-dashboard-ryz014a-or-ethernet-application-aws?r=1611756
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2. 事前準備 

2.1 TeraTeram のインストール 
(1) Tera Term のダウンロードサイトにアクセスする 

TeraTerm ダウンロードサイト(GitHub) 

(2) Tera Term のインストーラーをダウンロードする 

 
(3) インストーラーを実行し、案内に沿って Tera Term をインストールする 

(4) スタートメニューから Tera Term のアイコンをクリックして、Tera Term が起動することを確認する 

  

https://github.com/TeraTermProject/osdn-download/releases
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2.2 Python のインストール 
(1) Python のダウンロードサイトにアクセスする 

Python ダウンロードサイト 

(2) Python 3.11.0 のインストーラーをダウンロードする 

Python 3.11.0 の Download を選択 

 
 
使用する OS に合わせたインストーラーをダウンロードしてください。 

 
(3) インストーラーを実行し、案内に沿って Python をインストールする 

インストール画面で「Add python.exe to PATH」にチェックを入れてください。 

 
 

  

https://www.python.org/downloads/
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(4) コマンドプロンプトを起動し、Python 3.11.0 がインストールされていることを確認する 

以下のコマンドを実行して、情報が表示されることを確認してください。 

python -V 

 
 

(5) Python に暗号化ライブラリ「pycryptodome」をインストールする 

以下のコマンドを実行して、暗号化ライブラリをインストールしてください。  

pip install pycryptodome 

 
 

2.3 OpenSSL のインストール 
(1) Win32/Win64 OpenSSL のダウンロードサイトにアクセスする 

（Win32/Win64 OpenSSL Installer for Windows - Shining Light Productions (slproweb.com)） 

 

(2) OpenSSL のインストーラーをダウンロードする 

使用する OS に合わせたインストーラーをダウンロードしてください。 

 
 

(3) インストーラーを実行し、案内に沿って OpenSSL をインストールする 

OpenSSL の DLL の保存先には【The OpenSSL binaries directory】を選択してください。 

 

(4) スタートメニューから Win64 OpenSSL Command Prompt を実行する 

 

https://slproweb.com/products/Win32OpenSSL.html
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(5) コマンドプロンプトで openssl コマンドが実行できることを確認する 

以下のコマンドを実行して、バージョン情報が表示されることを確認してください。 

openssl version 

 

 
 

2.4 Renesas Image Generator のインストール 
Renesas Image Generator は、ファームウェアアップデートモジュールで使用するファームウェアイメー

ジを生成するユーティリティツールです。Renesas Image Generator はファームウェアアップデートモ

ジュールが使用する以下のイメージを生成することができます。 

 

• 初期イメージ：ブートローダとアプリケーションプログラムで構成されるシステムの初期設定時に 
フラッシュライタで書き込むイメージファイル(拡張子 mot) 

• 更新イメージ：ファームウェアアップデート対象のイメージファイル(拡張子 rsu) 
 

Renesas Image Generator は FIT モジュールの Firmware Update module に同梱されています。 

 

【注】 Firmware Update module Rev.2.00 以降のバージョンでは、Python スクリプトを使用したファーム
ウェア生成にのみ対応しております。 
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(1) FIT モジュールリストのサイトにアクセスしてミドルウェアを選択 

FIT モジュールリストサイト 

 
 

(2) ファームウェアアップデート モジュールをダウンロードする 

 
 

(3) ダウンロードしたファームアップデートモジュールを解凍する 

ファームアップデートモジュール内の RenesasImageGenerator.zip を解凍してください。

RenesasImageGenerator フォルダには Renesas Image Generator スクリプトファイル(image-gen.py)と各

デバイス用のパラメータファイル（*_ImageGenerator_PRM.csv）が含まれています。 

 

  

https://www.renesas.com/us/en/software-tool/fit-modules-list
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2.5 CK-RX65N の接続 

 
図 2-1 RYZ014A PMOD 裏面 

① RYZ014A PMOD の CN6 に SIM カードを挿入してください 

 
図 2-2 ベースボードおよび RYZ014A PMOD 表面 

② ベースボードの J16 の 1-2 をショートする（デバッグ許可） 

③ ベースボードの PMOD1 に RYZ014A PMOD を接続する 

④ ベースボードの J20 と PC を USB ケーブルで接続する（USB シリアル接続） 

⑤ RYZ014A PMOD の CN3 にアンテナを接続する 

⑥ RYZ014A PMOD の CN4 に USB ケーブルを接続し、電源供給する 

⑦ ベースボードの J14 と PC を USB ケーブルで接続する（デバッガ接続） 

【注】 予備の USB ケーブルをお持ちの場合は、手順⑥を実施してください。 
RYZ014A PMOD への電源供給を行わない場合、通信が不安定になる場合があります。 

 

 

  

①  

⑦

七 
④ 

③ 

⑤ 

② 

⑥ 
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3. AWS の設定 
FreeRTOS デモを実行するには、AWS アカウント（ルートユーザー、または AWS IoT と FreeRTOS 

クラウドサービスにアクセスできる権限を持つ IAM ユーザー）が必要です。 

AWS のアカウントと権限の設定方法は、https://docs.aws.amazon.com/freertos/latest/userguide/freertos-
prereqs.htmlを参照してください。 

OTA 更新の設定については、https://docs.aws.amazon.com/freertos/latest/userguide/ota-prereqs.html を
参照してください。 

次に、https://docs.aws.amazon.com/freertos/latest/userguide/freertos-prereqs.html の説明に従って、

AWS IoT にボードを登録する必要があります。 

デモが AWS と通信できるようにするには、2 章の説明に従ってソースコードを設定する必要がありま

す。 

 

  

https://docs.aws.amazon.com/freertos/latest/userguide/freertos-prereqs.html#freertos-account-and-permissions
https://docs.aws.amazon.com/freertos/latest/userguide/freertos-prereqs.html#freertos-account-and-permissions
https://docs.aws.amazon.com/freertos/latest/userguide/ota-prereqs.html
https://docs.aws.amazon.com/freertos/latest/userguide/freertos-prereqs.html#get-started-freertos-thing
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3.1 AWS コンソールへのサインイン 
(1) AWS（https://aws.amazon.com/）にアクセスし、AWS コンソールにサインインをクリック 

 

 
 

(2) E メールアドレス/アカウント ID を入力して 次へ をクリック 

サインインするユーザーがルートユーザーの場合は E メールアドレス、IAM ユーザーの場合はアカウント

ID を入力します。（過去サインインしていた場合、本手順はスキップされる場合があります） 

 
  

https://aws.amazon.com/
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(3) パスワードを入力して、サインインをクリック 

ルートユーザーの場合 

 
 

IAM ユーザーの場合 
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3.2 AWS のリージョン設定 
AWS にログイン後、画面右上にあるリージョンを設定してください。 

 
 

3.3 デバイスを AWS に登録する 
AWS のデモプロジェクト実行に必要な準備をします。下記のチュートリアルを参考に AWS の設定をし 

てください。 

 

3.3.1 ポリシーの設定 
接続するデバイスに対して AWS のリソースなどへアクセス許可（ポリシー）を設定します。 

本アプリケーションノートで接続するデバイスには、以下のポリシーを設定します。 

• iot:Connect  : AWS IoT に接続する 
• iot:Publish  :トピックをパブリッシュ（送信）する 
• iot:Subscribe :トピックをサブスクライブ（受信）する 
• iot:Receive  : AWS IoT からメッセージを受信する 

 

(1) 画面上部の検索窓に「IoT Core」と入力し、検索結果から IoT Core をクリック 
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(2) メニューの Security (安全性) > Policies (ポリシー) から Create policy (ポリシーを作成) を選択 

 

 
 

(3) ポリシー名を入力（例：rx65n_ota_demo_policy) 

 
 

(4) Policy statements (ポリシーステートメント) > Policy document (ポリシードキュメント) >  
Builder (ビルダー)で下図のように設定し、作成をクリック 

ステートメントは初期状態で 1 つのみのため、”ステートメントを追加 (Add new statement)”を押して追

加してください。 
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3.3.2 デバイス（モノ）を AWS IoT に登録 
 

(1) メニューの Manage (管理) > All devise (すべてのデバイス) > Things (モノ) から  
Create things(モノを作成)を選択 

 
 

(2) Create single thing (1 つのモノを作成)を選択して 次へ をクリック 
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(3) モノの名前を入力（例：rx65n_ota_demo_thing）して、次へ をクリック 

ここで入力したモノの名前は後の処理で使用するため、メモしておいてください。 

 

 
 



RX ファミリ RX65N における Amazon Web Services を利用した FreeRTOS OTA の実現

方法(v202210.01-LTS-rx-1.1.0 以降対応版) 

R01AN7037JJ0100  Rev.1.00  Page 18 of 67 
Sep.15.23  

(4) Device certificate (デバイス証明書) > Auto-generate a new certificate (新しい証明書を自動生成) を 
選択して 次へ をクリック 

 
 

(5) 証明書にポリシーをアタッチ 

「3.3.1 ポリシーの設定」で作成したポリシーを選択して、Create thing (モノを作成)をクリック 

 
 

  



RX ファミリ RX65N における Amazon Web Services を利用した FreeRTOS OTA の実現

方法(v202210.01-LTS-rx-1.1.0 以降対応版) 

R01AN7037JJ0100  Rev.1.00  Page 19 of 67 
Sep.15.23  

(6) 証明書／キーファイルをダウンロード 

証明書、プライベートキーはデバイス（モノ）における、パスワードに相当します。デバイスに証明書、

プライベートキーを登録することで、これらを使用してデバイスが AWS に接続可能となります。 

証明書、パブリックキー、プライベートキーは必ずここでダウンロードしてください。パブリックキー、

プライベートキーは、以降ダウンロードできません。 
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3.3.3 エンドポイントの確認 
エンドポイントはデバイス(モノ)における接続先(URL)に相当します。デバイスにエンドポイントを登録

することで、デバイスは指定したエンドポイントに接続します。 

(1) メニューの Settings (設定) からエンドポイントをメモしておきます。 
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3.4 Amazon S3 バケットの作成 
Amazon S3 はオンラインストレージの Web サービスで、更新用ファームウェアを格納するために使用し

ます。 

(1) サービスメニューから Storage(ストレージ) > S3 を選択 

 
 

(2) Buckets (バケット) から Create bucket (パケットを作成)を選択 
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(3) バケット名の入力（例：s3test-rx65n） 

 
 

バケット名はグローバルで一意である必要があります。以下のようなエラーメッセージが表示された場

合、すでに使用されている名前のため別の名前を使用してください。 
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(4) バケットの作成 

以下の設定を行い、Create bucket (バケットの作成)をクリック 

• Block Public Access setting for this bucket (このバケットのブロックパブリックアクセス設定) :  
  Block all public access (パブリックアクセスをすべて ブロック) 

• Bucket Versioning (バケットのバージョニング) : 有効にする 
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3.5 IAM ユーザーに OTA の実行権限を割り当てる 
OTA 更新ジョブを作成するためにアクセス権限が付与されたロールを作成します。 

(1) 画面上部の検索窓に「IAM」と入力し、検索結果から IAM をクリック 

 
(2) メニューの Roles (ロール) > Create role (ロールを作成)を選択 
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(3) Select trusted entity (信頼されたエンティティを選択) にて以下設定をして次へ 

• Trusted entity type (信頼されたエンティティタイプ)で AWS service (AWS サービス)を選択 
• Use cases for other AWS services (他の AWS サービスのユースケース)に IoT を選択 
• IoT にチェック 

 
 

(4) Add permissions (許可を追加)は変更せず次へ 
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(5) ロール名を入力 (例：ota_role_rx65n)して Create role (ロールを作成)をクリック 

 
 

 
 

(6) 作成したロールをクリック 
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(7) 「Attach policies (ポリシーをアタッチ)」を選択 

 
(8) Permissions policies (許可ポリシー)で検索ボックスに” AmazonFreeRTOSOTAUpdate”を入力して

Enter キーを押す 

 
 

(9) ” AmazonFreeRTOSOTAUpdate”にチェックをして Add permissions (許可を追加)をクリック 
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(10) Add permissions (許可を追加)から Create inline policy (インラインポリシーを作成)を選択 
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(11) JSON をクリックして、以下コードを張り付けて 次へ をクリック 

AWS 各種サービスに IAM ロールを渡す許可を設定します。 

 

[張り付けるコード]  

 

 

 
 

 

 

{ 
 "Version": "2012-10-17", 
 "Statement": [ 
  { 
   "Effect": "Allow", 
   "Action": [ 
    "iam:GetRole", 
    "iam:PassRole" 
   ], 
   "Resource": "*" 
  } 
 ] 
} 
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(12) ポリシー名を入力(例：rx65n_ota_demo_iam_policy)して Create policy (ポリシーを作成)をクリック 

 
 

 

(13) 再度、Add permissions (許可を追加)から Create inline policy (インラインポリシーを作成)を選択 

 
  



RX ファミリ RX65N における Amazon Web Services を利用した FreeRTOS OTA の実現

方法(v202210.01-LTS-rx-1.1.0 以降対応版) 

R01AN7037JJ0100  Rev.1.00  Page 31 of 67 
Sep.15.23  

(14) JSON をクリックして、以下コードを張り付けて 次へ をクリック 

更新ファームウェアを格納する Amazon S3 へのアクセス許可を追加します。 

[張り付けるコード]  

 

 

 
 

{ 
 "Version": "2012-10-17", 
 "Statement": [ 
  { 
   "Effect": "Allow", 
   "Action": [ 
    "s3:GetObjectVersion", 
    "s3:GetObject", 
    "s3:PutObject" 
   ], 
   "Resource": [ 
    "*" 
   ] 
  } 
 ] 
} 
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(15) ポリシー名を入力(例：rx65n_ota_demo_s3_policy)して Create policy (ポリシーを作成)をクリック 
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4. デバイスの設定 

4.1 鍵ペアと証明書の生成 
(1) スタートメニューから Win64 OpenSSL Command Prompt を起動する 

 
(2) ECDSA の CA 秘密鍵を作成するコマンドを実行 

以下のコマンドを実行します。 

openssl ecparam -genkey -name secp256r1 -out ca.key 

[実行結果] 

 
 

(3) 作成した CA 秘密鍵から CA 証明書を作成するコマンドを実行 

以下のコマンドを実行します。Country Name 以降は任意の文字列を入力してください。 

openssl req -x509 -sha256 -new -nodes -key ca.key -days 3650 -out ca.crt 

 
 

 

 

 

  

任意の文字列を入力する 
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(4) ECDSA の鍵ペアを作成するコマンドを実行 

以下のコマンドを実行します。 

openssl ecparam -genkey -name secp256r1 -out secp256r1.keypair 

 
 

(5) 作成した ECDSA の鍵ペアから証明書署名要求を作成するコマンドを実行 

以下のコマンドを実行します。Country Name 以降は任意の文字列を入力してください。最後の 2 行は空

白のまま Enter を押してください。 

openssl req -new -sha256 -key secp256r1.keypair > secp256r1.csr 

 
 

 

(6) 作成した証明書署名要求/CA 証明書/CA 秘密鍵から証明書を作成するコマンドを実行 

以下のコマンドを実行します。 

openssl x509 -req -sha256 -days 3650 -in secp256r1.csr -CA ca.crt -CAkey ca.key -CAcreateserial -out 
secp256r1.crt 

 
 

(7) ECDSA の鍵ペアから秘密鍵を抽出するコマンドを実行 

以下のコマンドを実行します。 

openssl ec -in secp256r1.keypair -outform PEM -out secp256r1.privatekey 

 
  

任意の文字列を入力する 

 

 

空白のまま Enter を押す 
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(8) ECDSA の鍵ペアから公開鍵を抽出するコマンドを実行 

以下のコマンドを実行します。 

openssl ec -in secp256r1.keypair -outform PEM -pubout -out secp256r1.publickey 
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4.2 初期バージョンのファームウェア構築 
初期バージョンのファームウェアの構築を行います。 

4.2.1 プロジェクトのインポート 
(1) デモプロジェクトのクローン 

GitHub (iot-reference-rx：FreeRTOS reference repository) からデモプロジェクトをクローンします。本

ドキュメントでは、Git for Windows を使用した場合のクローン方法を説明します。 

GitBush を起動し、以下のコマンドを実行してください。 

 

cd c: 

git clone https://github.com/renesas/iot-reference-rx 

 

 
 

【注】 e² studio に制限があるため、クローン先のパス長（任意のフォルダ名を含む）は 35 文字以内とし
てください。36 文字以上を指定するとプロジェクトのビルド時にエラーとなります。 
上記例では、C ドライブ直下にクローンしています。 

 

(2) e2 studio を起動 

(3) [File] > [Import…]を選択 

 

C ドライブ直下にクローンするため、Git Bash を起動後、 
カレントディレクトリを移動 (注) 
 
 

マスターブランチのクローンを作成 

https://github.com/renesas/iot-reference-rx
https://gitforwindows.org/
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(4) Existing Projects into Workspace (既存プロジェクトをワークスペースへ)を選択 

 
 

(5) Select root directory で 4.2.1(1)にてクローンしたフォルダを選択し、以下のプロジェクトにチェックし

て Finish をクリック 

• aws_ryz014a_ck_rx65n 
• boot_loader_ck_rx65n 
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4.2.2 プロジェクト環境設定の確認 
(1) 両方のプロジェクトの [プロジェクト] > [プロパティ] > [C/C++ビルド] > [設定]からツールチェーンを開

き、ツールチェーンが Renesas CC-RX になっていることを確認 
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(2) ツール設定を選択し、[Converter] > [出力]から [モトローラ S 形式ファイルを出力する]が選択されてい

ることを確認  
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4.2.3 プロジェクト設定 
 

(1) 各プロジェクトに公開鍵を設定する 

4.1(8)で作成した secp256r1.publickey の内容をコピーし、以下ファイルに定義されている

CODE_SIGNENR_PUBLIC_KEY_PEM に張り付けます。 

boot_loader_ck_rx65n ¥src¥key¥code_signer_public_key.h 
 

boot_loader_ck_rx65n ¥src¥key¥code_signer_public_key.h の CODE_SIGNENR_PUBLIC_KEY_PEM に

公開鍵を張り付けます。 

 
   

 
 

 

 

  

各行は””で囲み、行の最後には¥ が必要です、忘れずに入力してください 

（例：”xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx”¥ 
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(2) OTA アップデートデモの定義を許可にする 

aws_ryz014a_ck_rx65n¥src¥frtos_confit¥demo_config.h にある ENABLE_OTA_UPDATE_DEMO 定義を 1 
(許可)に設定してください。（デフォルト 0） 
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(3) プロジェクトの初期バージョンが 0.92 であることを確認する 

aws_ryz014a_ck_rx65n¥src¥frtos_config¥ demo_config.h のバージョン定義が以下になっていることを確

認します。 

• APP_VERSION_MAJOR 0 
• APP_VERSION_MINOR 9 
• APP_VERSION_BUILD 2 

 

  
 

(4) RYZ014A Cellular モジュール制御 FIT モジュール(r_cellular)の設定 

aws_ryz014a_ck_rx65n.scfg を開き、Components タグを選択。r_cellular の Access point name、Access 
point login ID、Access point password、Authenication protocol type を SIM カードに合わせて設定してくだ

さい。 
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CK-RX65N 付属の SIM カードを使用する場合は、以下アプリケーションノートの 「4.1.5 Activating SIM 
card」を参照し、SIM カードのアクティベーションを行ってください。 

SIM activation, Creating the trial account and using Dashboard with RYZ014A or Ethernet Application for 
AWS - Getting Started Guide (R01QS0064) 

 

(5) ファームウェアのデバイス設定(1) 

aws_ryz014a_ck_rx65n.scfg を開き、Board タグを選択。Board 選択の”…”をクリックしてください。 

 
 

(6) ファームウェアのデバイス設定(2) 

Target Device の”…”をクリックして” R5F565NEHxFB_DUAL”を選択してください。Target Board
は”Custom”になります。 

 
 

https://www.renesas.com/jp/ja/document/qsg/sim-activation-creating-trial-account-and-using-dashboard-ryz014a-or-ethernet-application-aws?r=1611756
https://www.renesas.com/jp/ja/document/qsg/sim-activation-creating-trial-account-and-using-dashboard-ryz014a-or-ethernet-application-aws?r=1611756
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(7) ファームウェアのデバイス設定(3) 

デバイスの変更を行うと以下の画面になるため”次へ”をクリック。 

 
(8) ファームウェアのデバイス設定(4) 

[Build Settigs]>[HardwareDebug]>[Toolcain Settings]にある、[ROM から RAM へマップするセクション

(-rom)]と[セクション(-start)]のチェックを外し、”終了”をクリックしてください。 
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(9) ブートローダのデバイス確認 

boot_loader_ck_rx65n.scfg を開き、Board タグを選択。Device が” R5F565NEHxFB_DUAL”になっている

ことを確認してください。 
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4.2.4 初期ファームウェアの作成 
ブートローダ(boot_loader_ck_rx65n)とファームウェア(aws_ryz014a_ck_rx65n)を結合して初期ファーム

ウェアを作成します。 

 

(1) ファームウェア(aws_ryz014a_ck_rx65n)のベクタ変更 

aws_ryz014a_ck_rx65n のプロジェクトから、[Project] > [Properties]を選択。 

C/C++ Build > Settings から、Tool Settings の Linker > Section から Section Viewer を開き、

EXCEPTVECT を 0xFFFEFF80 に、RESETVECT を 0xFFFEFFFC に割り当てます。 

その後、ビルドを行います。 
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(2) Renesas Image Generator を使用して初期ファームウェアを生成 

Renesas Image Generator フォルダに以下のファイルを格納します。 

• 4.2.4(1)でビルド実施結果  aws_ryz014a_ck_rx65n.mot 
• ブートローダのビルド実施結果  boot_loader_ck_rx65n.mot 
• 4.1(7)で作成した秘密鍵  secp256r1.privatekey 

 

コマンドプロンプトを起動し、Renesas Image Generator フォルダへ移動して以下のコマンドを実行する

と、userprog.mot ファイルが生成されます。 

python image-gen.py -iup aws_ryz014a_ck_rx65n.mot -ip RX65N_DualBank_ImageGenerator_PRM.csv -o 
userprog -ibp boot_loader_ck_rx65n.mot -key secp256r1.privatekey -vt ecdsa -ff RTOS 

 

(3) Renesas Flash Programmer を起動し、erase.rpj プロジェクトを開く 

erase.rpj プロジェクトは、本サンプルプログラムの以下フォルダにあります。 

¥Projects¥aws_ryz014a_ck_rx65n¥flash_project¥erase_from_bank1 
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(4) スタートを押し、デバイスのイレーズを実施 

 
(5) flash_project.rpj プロジェクトを開く 

flash_project.rpj プロジェクトは、本サンプルプログラムの以下フォルダにあります。 

¥Projects¥aws_ryz014a_ck_rx65n¥flash_project¥ 

 
 



RX ファミリ RX65N における Amazon Web Services を利用した FreeRTOS OTA の実現

方法(v202210.01-LTS-rx-1.1.0 以降対応版) 

R01AN7037JJ0100  Rev.1.00  Page 49 of 67 
Sep.15.23  

(6) 4.2.4(2)で作成した初期ファームウェア(userprog.mot)を選択する 

  
 

 
 
 
 
(7) ファームウェアの書き込みを行う 
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4.2.5 AWS IoT 情報の登録 
AWS IoT の情報は aws_ryz014a_ck_rx65n を動作させて、TeraTerm にて設定します。設定した情報は

データフラッシュに書き込まれます。 

 

(1) TeraTerm を起動して、メニューの File > New Connection…から、Serial を選択して OK をクリック 

 
 

(2) メニューの Setup > Terminal…を開き、New-line の Receive を Auto、Transmit を CR+LF を選択して

OK をクリック 
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(3) メニューの Setup > Serial port…を開いて Speed を 115200 に設定して New setting をクリック 

 
 

(4) CK-RX65N の J16 を RUN 側に接続し、RESET SW を押す 

 
 

 

  



RX ファミリ RX65N における Amazon Web Services を利用した FreeRTOS OTA の実現

方法(v202210.01-LTS-rx-1.1.0 以降対応版) 

R01AN7037JJ0100  Rev.1.00  Page 52 of 67 
Sep.15.23  

(5) TeraTerm の画面にメニューが表示されたのち、10 秒以内に「CLI」と入力して Enter キーを押す 
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(6) 3.3.2(6)でダウンロードした証明書を登録する 

TeraTerm にて「conf set cert 」と入力したのち、証明書ファイル(xxxx-certificate.pem.crt)を TeraTerm
にドラッグアンドドロップ（ファイル送信）してください。最後に TeraTerm 上で「Enter」を押してくだ

さい。 

 
 
 

 
 

 

  

  

“conf set cert “を入力した後に、 
証明書ファイルをドラッグアンドドロップする 
その後”Enter”を押す 



RX ファミリ RX65N における Amazon Web Services を利用した FreeRTOS OTA の実現

方法(v202210.01-LTS-rx-1.1.0 以降対応版) 

R01AN7037JJ0100  Rev.1.00  Page 54 of 67 
Sep.15.23  

(7) 3.3.2(6)でダウンロードしたプライベートキーを登録する 

TeraTerm にて「conf set key 」と入力したのち、プライベートキーファイル(xxxx- private.pem.key)を
TeraTerm にドラッグアンドドロップ（ファイル送信）してください。最後に TeraTerm 上で「Enter」を押

してください。 

 
 
 

 
 

  

“conf set key “を入力した後に、プライベートキー

ファイルをドラッグアンドドロップする 
その後”Enter”を押す 
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(8) 3.3.2(3)で設定したモノの名前、および 3.3.3(1)で控えたエンドポイントを登録する 

TeraTerm で以下のコマンドを実行する 

conf set thingname [モノの名前] 

conf set endpoint [エンドポイント名] 

 
 

(9) 4.1(6)で生成した鍵ペア証明書(secp256r1.crt)を登録する 

TeraTerm にて「conf set codesigncert 」と入力したのち、鍵ペア証明書(secp256r1.crt)を TeraTerm にド

ラッグアンドドロップ(ファイル送信)してください。 

 

※証明書ファイルの改行コードは LF に変更してから張り付けてください 

  
 

 

 

 
  

“conf set codesigncert “を入力した後に、 
鍵ペア証明書をドラッグアンドドロップする 
その後”Enter”を押す 
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(10) AWS IoT の設定を Commit（データフラッシュに書き込み） 

TeraTerm で以下のコマンドを実行する 

conf commit 

 
 

(11) Reset 実行 

TeraTerm で以下のコマンドを実行する 

reset 

 

リセット実行後、TeraTerm に通信ログが表示され、OTA ジョブ待ちになっていることを確認する。 
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5. ファームウェアの更新 

5.1 更新用ファームウェア構築 

5.1.1 バージョンの変更 
(1) ファームウェアのバージョンを v0.9.3 に変更する 

aws_ryz014a_ck_rx65n¥src¥frtos_config¥ demo_config.h の APP_VERSION_BUILD 定義を 3 にしてビル

ドを再実行する。 

  
 

(2) Renesas Image Generator を使用して更新ファームウェアを生成 

5.1.1(1)で再ビルドしたファームウェア(aws_ryz014a_ck_rx65n.mot)を Renesas Image Generator フォル

ダに上書きし、コマンドプロンプトで以下コマンドを実行します。 

 

python image-gen.py -iup aws_ryz014a_ck_rx65n.mot -ip RX65N_DualBank_ImageGenerator_PRM.csv -o 
user_093 -key secp256r1.privatekey -vt ecdsa -ff RTOS 

 

上記コマンドで、user_093.rsu ファイルが生成されます。 
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5.2 ファームウェアの更新 
AWS にて、ファームウェアの更新を行うための OTA 更新ジョブを作成します。 

 

(1) IoT Core のメニューから Manage(管理) > Remote actions(リモートアクション) > Jobs(ジョブ)から

Create job(ジョブを作成)を選択 

 
 

(2) Create FreeRTOS OTA update job (FreeRTOS OTA 更新ジョブを作成)を選択して次へ 
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(3) ジョブ名を入力(例：rx65n_ota_demo_job)して次へ 

 
 

(4) Devices to update(更新するデバイス)をクリックして、更新するデバイスを選択 
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(5) Create new profile(新しいプロファイルの作成)を選択 

 
 

過去にプロファイルを作成していた場合は、(5)～(9)は省略できます。Choose existing code signing 
profile (既存のコード署名プロファイル)で過去に作成したプロファイルを選択してください。 
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(6) プロファイル作成(1) プロファイル名、デバイスハードウェアプラットフォーム 

• プロファイル名を入力(例: rx65n_ota_demo_profile) 
• デバイスハードウェアプラットフォームに「Windows Simulator」を選択 

 

 
 

(7) プロファイル作成(2) 証明書のインポート 

• コード署名証明書で新しい署名証明書のインポートをクリック 
• Certificate body(証明書本文)に 4.1(6) で作成した secp256r1.crt を選択 
• Certificate private key(証明書のプライベートキー)に 4.1 で作成した secp256r1.privateky を選択 
• Certificate chain(証明書チェーン)に 4.1(3)で作成した ca.crt を選択 
• Import(インポート)をクリック 
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(8) プロファイル作成(3) デバイスのコード署名証明書のパス名を入力して Create をクリック 

パス名は任意です。(例：dummy) 

 
 

(9) プロファイルに先ほど作成したプロファイル名が選択されているのを確認 
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(10) 更新用ファームウェアのアップデート 

• Upload a new file (新しいファイルをアップロードする)を選択 
• File to upload (アップロードするファイル)に 5.1.1(2)で作成した usr093.rsu を選択 
• Browse S3(S3 をブラウズ)に 3.4 で作成した S3 バケットを選択 
• Path name of file on device(デバイス上のファイルのパス名)を入力 

 (パス名は任意「例: /device/updates」) 

 
 

(11) Role (ロール)に 3.5(5)で作成したロールを選択して次へ 
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(12) Create job (ジョブの作成)をクリック 

 
 

 

(13) ファームウェアの受信が完了するまで待つ 

ジョブが開始されると、受信およびファームウェアの書き込みを行います。 

 
  

受信を開始すると、Received の回数が加算されます  
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更新が完了すると、リセットがかかり最初のメニューが表示されます。 

 
 

(14) ファームウェアのバージョンが Ver0.9.3 になっていることを確認 

 
 

 

  



RX ファミリ RX65N における Amazon Web Services を利用した FreeRTOS OTA の実現

方法(v202210.01-LTS-rx-1.1.0 以降対応版) 

R01AN7037JJ0100  Rev.1.00  Page 66 of 67 
Sep.15.23  

6. トラブルシューティング 
本サンプルを実行する際に想定されうるトラブルおよびその解決策を下表に示します。 

 

表 6-1 トラブルシューティング 

No トラブル内容 原因 解決策 参照 
1 初期ファームウェ

アの作成コマンド

が失敗する 

Python のパスが通ってい

ない 
Python を再インストールしてくだ

さい。また、2.2(3)の手順で、

「Add python.exe to PATH」に

チェックが入っていることを確認し

てください。 

2.2 

2 暗号化ライブラリがイン

ストールされていない 
暗号化ライブラリをインストールし

てください。 
2.2(5) 

3 初期ファームウェ

アが書き込めない 
CK-RX65N がデバッグ設

定になっていない 
CK-RX65N の J16 の設定が 1-2
ショート（デバッグ）になっている

ことを確認してください。 

2.5 

4 初期ファームウェ

アが起動しない 
CK-RX65N が RUN 設定

になっていない 
CK-RX65N の J16 の設定が 2-3
ショート（RUN）になっているこ

とを確認してください。 

4.2.5(4) 

5 セルラー通信が開

始できない 
RYZ014A PMOD が正し

く接続されていない 
RYZ014A PMOD の接続を見直して

ください。 
2.5 

6 SIM カードが挿入されて

いない 
SIM カードを挿入してください。 2.5 

7 SIM カードの設定が正し

くされていない 
r_cellular のコンフィグ設定を見直

してください。 
4.2.3(4) 

8 CK-RX65N 付属の SIM
カードを使用しており、

かつ SIM カードのアク

ティベーションができて

いない 

SIM カードのアクティベーション

を行ってください。 
4.2.3(4) 

9 セルラー通信中に

エラーが発生する 
通信環境が悪い RYZ014A PMOD にアンテナおよび

電源の接続を行ってください。 
また、アンテナを窓際など通信環境

の良い場所においてください。 

2.5 

10 AWS への接続で

エラーが発生する 
AWS IoT 情報が設定され

ていない、または間違え

ている 

再度、AWS IoT 情報の設定を行っ

てください。 
4.2.5 

11 ブートローダ起動

後にファームウェ

アが起動しない 

ブートローダに公開鍵が

正しく設定がされていな

い 

ブートローダの公開鍵設定を見直し

てください。 
4.2.3(1) 

12 OTA アップデート

後にファームウェ

アが起動しない 

ファームウェアに公開鍵

が正しく設定されていな

い 

ファームウェアの公開鍵設定を見直

してください。 
4.2.3(1) 

13 デバイス選択が正しく設

定されていない 
ファームウェアおよびブートローダ

のデバイス設定を見直してくださ

い。 

4.2.3(5) 
～ 
4.2.3(9) 
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製品ご使用上の注意事項 
ここでは、マイコン製品全体に適用する「使用上の注意事項」について説明します。個別の使用上の注意事項については、本ドキュメントおよびテク

ニカルアップデートを参照してください。 

1. 静電気対策 

CMOS 製品の取り扱いの際は静電気防止を心がけてください。CMOS 製品は強い静電気によってゲート絶縁破壊を生じることがあります。運搬や保

存の際には、当社が出荷梱包に使用している導電性のトレーやマガジンケース、導電性の緩衝材、金属ケースなどを利用し、組み立て工程にはアー

スを施してください。プラスチック板上に放置したり、端子を触ったりしないでください。また、CMOS 製品を実装したボードについても同様の扱

いをしてください。 

2. 電源投入時の処置 

電源投入時は、製品の状態は不定です。電源投入時には、LSI の内部回路の状態は不確定であり、レジスタの設定や各端子の状態は不定です。外部

リセット端子でリセットする製品の場合、電源投入からリセットが有効になるまでの期間、端子の状態は保証できません。同様に、内蔵パワーオン

リセット機能を使用してリセットする製品の場合、電源投入からリセットのかかる一定電圧に達するまでの期間、端子の状態は保証できません。 

3. 電源オフ時における入力信号 

当該製品の電源がオフ状態のときに、入力信号や入出力プルアップ電源を入れないでください。入力信号や入出力プルアップ電源からの電流注入に

より、誤動作を引き起こしたり、異常電流が流れ内部素子を劣化させたりする場合があります。資料中に「電源オフ時における入力信号」について

の記載のある製品は、その内容を守ってください。 

4. 未使用端子の処理 

未使用端子は、「未使用端子の処理」に従って処理してください。CMOS 製品の入力端子のインピーダンスは、一般に、ハイインピーダンスとなっ

ています。未使用端子を開放状態で動作させると、誘導現象により、LSI 周辺のノイズが印加され、LSI 内部で貫通電流が流れたり、入力信号と認識

されて誤動作を起こす恐れがあります。 

5. クロックについて 

リセット時は、クロックが安定した後、リセットを解除してください。プログラム実行中のクロック切り替え時は、切り替え先クロックが安定した

後に切り替えてください。リセット時、外部発振子（または外部発振回路）を用いたクロックで動作を開始するシステムでは、クロックが十分安定

した後、リセットを解除してください。また、プログラムの途中で外部発振子（または外部発振回路）を用いたクロックに切り替える場合は、切り

替え先のクロックが十分安定してから切り替えてください。 

6. 入力端子の印加波形 

入力ノイズや反射波による波形歪みは誤動作の原因になりますので注意してください。CMOS 製品の入力がノイズなどに起因して、VIL（Max.）か

ら VIH（Min.）までの領域にとどまるような場合は、誤動作を引き起こす恐れがあります。入力レベルが固定の場合はもちろん、VIL（Max.）から VIH

（Min.）までの領域を通過する遷移期間中にチャタリングノイズなどが入らないように使用してください。 

7. リザーブアドレス（予約領域）のアクセス禁止 

リザーブアドレス（予約領域）のアクセスを禁止します。アドレス領域には、将来の拡張機能用に割り付けられている リザーブアドレス（予約領

域）があります。これらのアドレスをアクセスしたときの動作については、保証できませんので、アクセスしないようにしてください。 

8. 製品間の相違について 

型名の異なる製品に変更する場合は、製品型名ごとにシステム評価試験を実施してください。同じグループのマイコンでも型名が違うと、フラッ

シュメモリ、レイアウトパターンの相違などにより、電気的特性の範囲で、特性値、動作マージン、ノイズ耐量、ノイズ幅射量などが異なる場合が

あります。型名が違う製品に変更する場合は、個々の製品ごとにシステム評価試験を実施してください。 
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